
Activity Overview
Think for a moment about what your life would be like if you couldn’t see. How would 
you be able to distinguish between different objects or people? How would you know 
where you are and how to get somewhere? How would you know what’s safe to eat 
or drink? How would you experience beauty? While many people who are blind have 
learned to rely on other senses, most of us depend heavily on our sense of vision to 
accomplish everyday tasks and to keep us safe. Now think for a moment about what 
robots could do if they could see like you see. How much more would they be able to 
accomplish?

Vision sensors like the Pixy2 camera are useful for all kinds of robotics applications and 
tasks. Making navigation decisions, tracking and sorting objects, identifying patterns, 
avoiding obstacles, and detecting motion are just a few examples of how vision can 
enhance a robot. To accomplish these and other tasks, Pixy2 provides lots of data to the 
PRIZM® controller. For example, when an object is detected by Pixy2, it sends the object’s 
x- and y-position; its height, width, angle, color, and tracking ID number; and the number 
of frames (amount of time) the object has been tracked to PRIZM. If multiple objects are 
detected by Pixy2, then this information is provided for each object. Because Pixy2 can 
track lots of objects at the same time, a fast line of communication is needed between 
Pixy2 and PRIZM. That’s why Pixy2 needs to be connected to PRIZM’s I2C port. I2C stands 
for inter-integrated circuit and is the fastest way to send large amounts of data to PRIZM.

The Pixy2 camera has three different modes: video mode, line tracking mode, and color 
connected components (CCC) mode. In this guide, you’ll complete an activity for each 
mode and explore some of the benefits of giving vision to your TETRIX® robots.

Parts Needed
To complete this activity, each team will need the following items:

• Fully assembled PRIZM TaskBot

• Pixy2 camera

• This sensor is available from:

Charmed Labs

CharmedLabs.com

Product ID: Pixy 2

A list of Pixy2 distributors is on the website.

• TETRIX Pixy2 Cable Adapter (46017)

• This adapter board is available at Pitsco.com/TETRIX-Pixy2-Camera-Adapter.

• Micro USB cable

• Standard TETRIX USB cable

• Charged TETRIX 12-volt battery

• Several blank sheets of paper

• Black marker

• Clear tape

• Computer with the following installed:

• Arduino Software (IDE) and Arduino libraries for TETRIX PRIZM and Pixy2

• Both libraries can be downloaded from the Pitsco website at  
Pitsco.com/TETRIX-PRIZM-Robotics-Controller.

• PixyMon software

• Download here: Pixycam.com/downloads-pixy2/

Activity
Object Recognition with 
Pixy2 Camera

Difficulty
Medium

Class Time
270 minutes

Grade Level
• High school

Learning Focus
• Camera vision

• Object recognition

Note: The activities in this guide use the TETRIX Pixy2 
Camera Cable Adapter to connect the Pixy2 camera to 
PRIZM. However, Pitsco also has a Pixy2 camera enclosure 
that you can 3-D print yourself. You can download the 
CAD file for the camera enclosure from this link:

Pitsco.com/TETRIX-PRIZM-Robotics-Controller#resources

1

TETRIX MAX Pixy2 Camera Extension ActivityOverview

http://CharmedLabs.com
http://Pitsco.com/TETRIX-Pixy2-Camera-Adapter
http://Pitsco.com/TETRIX-PRIZM-Robotics-Controller
http://Pixycam.com/downloads-pixy2/
http://Pitsco.com/TETRIX-PRIZM-Robotics-Controller#resources


Before You Begin
Before you begin this activity, you’ll need to install the TETRIX Pixy2 Camera Library. 
There are two methods of installing a library into the Arduino Software (IDE).

Importing a .zip Library
In the Arduino Software (IDE), navigate to Sketch > Include Library. From the 
drop-down menu, select Add .ZIP Library.

You will be prompted to select the library you would like to add. Navigate to the 
location where you saved the TETRIX Pixy2 Camera Library. Select and open the 
TETRIX_Pixy2_Camera.zip file.

Return to the Sketch > Include Library menu. You should now see the TETRIX_
Pixy2_Camera library near the bottom of the drop-down menu. It is ready to be 
used. However, the example sketches used in this activity might not be available 
until the Arduino Software (IDE) has been restarted.

Manual Installation
To install the Pixy2 library manually, follow the instructions provided in the PRIZM 
Programming Guide’s Software Setup section.

Lesson Guide
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Activity Setup
For this activity, you’ll need to connect your PRIZM controller to a TETRIX 12-volt 
battery using the TETRIX on/off switch. Then, connect a Pixy2 camera to the I2C 
port on PRIZM. Flip the on/off switch to turn on PRIZM.

Configuring the Pixy2 Camera
Before you can use the Pixy2 camera, it must be configured for I2C communication. 
Follow these steps to complete the configuration process.

1. Attach the TETRIX cable adapter to the Pixy2 camera. To do this, make 
sure the black box on the back of the camera with pins in it aligns with 
the black box on the front of the TETRIX cable adapter. Slide the two 
pieces together. Friction between the pins and pin connectors should 
hold the two pieces together.
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2. Connect the Pixy2 camera to the computer using the micro USB cable. 
You should see the LED on the Pixy2 light up for a short time.

3. Launch the PixyMon software.

4. Click the gear icon in the top-left corner of the PixyMon software to 
bring up the Configure window.

5. In the Configure window, select the Pixy Parameters (saved on Pixy) 
tab. Then, click the Interface tab.

Lesson Guide

4

TETRIX MAX Pixy2 Camera Extension Activity



6.  From the Data out port drop-down menu, select I2C.

7.  Click Apply to apply the changes, and close the Configure window.

Lesson Guide
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Video Mode
The Pixy2 camera’s video mode is for displaying video through the PixyMon 
software. However, this mode also has the ability to detect color, making it an 
accurate color sensor. In this activity, you’ll explore some of the features of Pixy2’s 
video mode.

Building the Knowledge Base
The Pixy2 camera captures a lot of data. To avoid overwhelming PRIZM with data, 
Pixy2 has its own onboard processor to analyze the data it collects. It then sends 
only the most useful data to PRIZM. To speed up communication between Pixy2 
and PRIZM, data needs to be sent back and forth in an efficient manner. That means 
data needs to be of a certain format or data type. 

There are lots of different data types that PRIZM will recognize. For example:

• A Boolean variable can have only two values – either true (1) or false (0). 

• A byte variable can be any number from 0 to 255 and is represented as a 
series of eight 1s and 0s.

• An integer variable has a range of -32,768 to 32,767.

• A long variable is even larger and has a range from -2,147,483,648 to 
2,147,483,647. 

In essence, the bigger a piece of data is, the more memory and processing time it 
takes to analyze the data. When dealing with stored data, good programmers use 
the most efficient data type possible based on the values the data could be. For 
example, it wouldn’t be good practice to use a long-type variable to store a number 
that could only be either a 1 or 0. 

One problem with using these standard data types is that they have different 
meanings on different systems. For example, an integer data type for PRIZM holds 
16 bits of data, but an integer data type on other systems such as other Arduino 
microcontrollers or your computer might hold 32 or even 64 bits of data. When 
these systems need to pass integer-type data back and forth, they can get confused 
if they aren’t the same size.

To avoid confusion, programmers use the size_t data type where they can declare 
the exact size of a variable in bits. The following table shows some examples of the 
size_t data type and their standard equivalents.

Size_t
Data Type Description Range Standard 

Designation Example

uint8_t Unsigned integer of 8 bits
(1 byte) 0 to 255 byte uint8_t variableName = 100;

int8_t Signed integer of 8 bits
(1 byte) -127 to 128 (none) int8_t variableName = -50;

uint16_t Unsigned integer of 16 bits
(2 bytes) 0 to 65,535 unsigned int uint16_t variableName = 60,000;

int16_t Signed integer of 16 bits
(2 bytes) -32,768 to 32,767 int int16_t variableName = -30,000;

uint32_t Unsigned integer of 32 bits
(4 bytes) 0 to 4,294,967,295 unsigned long uint32_t variableName = 4,000,000,000;

int32_t Signed integer of 32 bits
(4 bytes)

-2,147,483,648 to 
2,147,483,647 long int32_t variableName = -2,000,000,000;
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Opening the Sketch
There are millions of colors that the Pixy2 camera can see (16,581,375 colors to be 
exact). Each of these colors can be expressed as a combination or red, green, and 
blue where the amount of each color is represented by a byte value between 0 and 
255. The following table shows a few color combination examples.

In this first sketch, you’ll use the Pixy2 camera to return the RGB color combination 
that the Pixy2 sees at the center of the frame. 

Launch the Arduino Software (IDE). The TETRIX Pixy2 Camera Library includes 
a few example sketches to help you get going with Pixy2. Open the PixyCam_
PRIZM_Get_RGB sketch by selecting File > Examples > TETRIX_Pixy2_Camera > 
PixyCam_PRIZM_Get_RGB. The sketch will open in a new sketch window.

Executing the Code
Connect the PRIZM controller to the computer using the standard TETRIX USB 
cable. With the PRIZM on, make sure to select the correct port in the Tools menu 
of the Arduino IDE. Upload the example sketch to the PRIZM. When the code is 
uploaded, the green LED will light up, indicating the code is ready to execute. 

From the Tools menu, launch the serial monitor. This will let you observe the color 
combination detected by the Pixy2 camera. Press the green Start button on the 
PRIZM controller. Place different colored objects in front of the Pixy2 camera. Watch 
the serial monitor to observe the RGB color combination detected by Pixy2.

Color R Value G Value B Value Sample

Black 0 0 0

White 255 255 255

Red 255 0 0

Orange 255 153 0

Yellow 255 255 0

Green 0 255 0

Teal 0 255 255

Blue 0 0 255

Purple 255 0 255

Note: In the bottom-right corner of 
the serial monitor, make sure the first 
drop-down menu is set to No line 
ending. The baud rate drop-down 
menu should be set to 9,600.
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Moving Forward
The code for this sketch starts by including two libraries – the PRIZM library and 
the Pixy2I2C library. These libraries enable you to use the functions and commands 
associated with PRIZM and the Pixy2 camera.

The next line of code defines the way Pixy2 communicates with PRIZM – through 
the I2C port.

Also before the void setup() section are two commands that instantiate (or name) 
the Pixy2 object and the PRIZM object.

The void setup() function includes the command to start PRIZM when the green 
Start button is pressed, to start the serial monitor, and to print the word “Starting…” 
to indicate the Pixy2 camera is running.

Following these commands is the pixy.init() command. This is the command that 
initializes the Pixy2 camera. This command should always be executed before any 
other Pixy2 commands or functions.

The final command in the void setup() function is pixy.changeProg(“video”). 
The Pixy2 camera has three different modes that it can operate – color connected 
components (CCC), line tracking, and video. The pixy.changeProg() command 
changes among the three modes. The video mode simply displays the video feed 
from the camera in the PixyMon software. It can also be used to identify the RGB 
color combinations of objects that are in the camera frame.

The void loop() function starts by declaring three new variables – r, g, and b. These 
variables are unsigned integer variables of 8 bits, meaning that they can have a 
range from 0 to 255. Normally when variables are declared, it is common to give 
each variable its own command line. However, if the variables are of the same type 
(as in this case), then a shortcut can be used where the variables can be written on 
one command line and separated by commas. Both sections of code shown here 
accomplish the same thing.

The function pixy.video.getRGB(x-position, y-position, &r, &g, &b) is the function 
that gets the RGB values from the camera and stores them into the r, g, and b 
variables.

or
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This function has five parameters. The first two parameters are the x- and 
y-positions of the camera frame where you want to get the RGB values from. The 
frame width of Pixy2 is 315 pixels, so the x-position can be anywhere from 0 to 315. 
A value of 0 indicates the left side of the camera frame, and a value of 315 indicates 
the right side. Similarly, Pixy2’s frame height is 207 pixels, so the y-position can 
range from 0 to 207, where 0 is at the top of the frame and 207 is at the bottom of 
the frame.

In the sketch, the x-position is the pixy.frameWidth divided by 2, which would be 
the middle of the frame. The y-position is the pixy.frameHeight divided 2. So, this 
function returns the RGB values from the middle of the frame.

Look one more time at the function for returning the RGB values.

Notice that the last three parameters use an & symbol to assign the red color value 
to the r variable, the green color value to the g variable, and the blue color value to 
the b variable. This & symbol indicates a pointer variable. This guide won’t get into 
the details of how pointer variables work. For now, you can think of them like the 
index of a book. They help the sketch find the location of stored information.  

The last several lines of the void loop() function output the r, g, and b variables to 
the serial monitor. A short delay of 100 milliseconds slows the loop down so that 
the serial monitor is more readable. 

Real-World Connection
Color sensors have a wide range of applications. Manufacturing robots often use 
color sensors to inspect and sort components or products. Color sensors in modern 
vehicles can recognize the lines on the road and provide feedback to the driver. In 
the medical field, color sensors are used to detect skin conditions such as psoriasis 
and neurodermatitis and help doctors prescribe treatments. At most hardware 
stores, color sensors are used to detect the color of a painted object and can create 
paint that matches that color.
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Building Interlude: Adding the Pixy2 Camera to the TaskBot

Step 1 Parts Needed

Tip: Instructions for building the TaskBot 
can be found in the TETRIX PRIZM Robotics 
Controller Programming Guide that came 
with your TETRIX set.

Note: The servo and flag mechanism at the 
back of the bot will not be used for this activity. 
It is your decision whether you remove the flag 
mechanism or not.

Step 1.0
If your TaskBot has the ultrasonic and line finder sensors attached to the front, you’ll need to remove these components to 
make room for the Pixy2 camera.

Building Interlude

Assembled TaskBot
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Partial assembly should look like this.

Step 2 Parts Needed

Flats
Part No.  Part Name Quantity
39274 TETRIX MAX Flat 64 mm x 27 mm . . . . . . . . . . . . . . . . . . . . . . . . 1

Posts & Standoffs
Part No.  Part Name Quantity
39107 TETRIX Stand-Off Post 6-32 x 32 mm . . . . . . . . . . . . . . . . . . . . . 2

Plates & Brackets
Part No.  Part Name Quantity
39062 TETRIX MAX L Bracket . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
41790 TETRIX MAX Adjustable Angle Corner Bracket . . . . . . . . . . . 1

Electronics & Control
Part No.  Part Name Quantity
46017 TETRIX Pixy2 Camera Cable Adapter . . . . . . . . . . . . . . . . . . . . . 1
NA Pixy2 Camera . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

Note: The activities in this guide use the TETRIX Pixy2 
Camera Cable Adapter to connect the Pixy2 camera to 
PRIZM. However, Pitsco also has a Pixy2 camera enclosure 
that you can 3-D print yourself. You can download the 
CAD file for the camera enclosure from this link:

Pitsco.com/TETRIX-PRIZM-Robotics-Controller#resources

Building Interlude

Nuts, Screws, & Fasteners
Part No.  Part Name Quantity
39094 Kep Nut . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6
39098 Socket Head Cap Screw 6-32 x 5/16" . . . . . . . . . . . . . . . . . . . . . 6
39111 Button Head Cap Screw 3/8" . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4
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Step 2.0

Detail

Step 2.1

Building Interlude

Note: You might 
need to remove 
the battery to 
complete this step.
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Building Interlude

Step 2.2

Step 2.3
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Building Interlude

Step 2.4

Step 2.5
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Finished assembly should look like this.

Building Interlude

Detail
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Line Tracking Mode
If you’ve completed the PRIZM Programming Guide, then you know about PRIZM’s 
ability to detect lines and follow them using a line finder sensor. However, the Pixy2 
camera takes line following to the next level. In line tracking mode, Pixy2 not only 
detects lines of various widths but can also detect intersections and bar codes as 
well. In this activity, you’ll explore the basics of Pixy2’s line tracking mode.

Building the Knowledge Base
Pixy2 uses vectors to represent the direction a line is going. A vector is a quantity 
that has two parameters: direction and magnitude (or strength). Vectors are 
symbolized as arrows where the length of the arrow represents the magnitude 
and where the arrow is pointed represents direction. For example, velocity is often 
represented as a vector where the length of the arrow (magnitude) represents the 
speed an object is traveling and where the arrow is pointed represents the direction 
the object is moving.

Pixy2 uses vectors to represent the distance and direction that a robot could travel 
to follow a line. But before the TaskBot can follow a line, you need to train the Pixy2 
camera in what to look for.

Follow these steps to get started:

1. Leave the Pixy2 camera attached to the TaskBot. Connect the Pixy2 
camera to the computer using the micro USB cable. You should see the 
LED on the Pixy2 light up for a short time.

2. Launch the PixyMon software. The software should display the video 
feed from the camera.

3. From the Program menu in the PixyMon software, choose line_tracking.

4. Next, you’ll need a line for the robot to detect. The Pixy2 can follow all 
kinds of lines. Get a blank piece of paper and a black marker. With the 
marker, draw a line down the center of the piece of paper. Make sure that 
the line is somewhat straight. It’s OK if the line isn’t perfect, though.
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Note: At this point, you might see 
a red arrow labeled “Vector” in the 
camera view frame. If you don’t see 
the arrow at this time, don’t worry. 
In the next several steps, you’ll train 
Pixy2 to see the line and create this 
Vector arrow.

5. Place the paper under the Pixy2 camera. Make sure that the line reaches 
from the bottom to the top of the camera’s viewing frame in the 
PixyMon software.

6. Click the gear icon in the top-left corner of the PixyMon software to 
bring up the Configure window.

7. Drag the Configure window to a screen location where it is not directly 
on top of the line in the PixyMon software camera frame. In the 
Configure window, make sure you are on the Pixy Parameters (saved on 
Pixy) tab. Then, click the Tuning tab.

Lesson Guide
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Note: You might need to tweak 
this slider after making other 
adjustments.

Note: Even when the parameters 
are at their optimum settings, the 
vector in the camera frame might 
jump around a bit. This is normal.

Note: The Pixy2 camera has many 
more features for line tracking 
such as detecting intersections and 
reading bar codes. You can learn 
more about Pixy2’s line tracking 
capabilities at the following link:

https://docs.pixycam.com/wiki/
doku.php?id=wiki:v2:line_tracking

8. In order for Pixy2 to detect the line, you’ll need to change some of the 
Tuning parameters. Your goal is to get a red “Vector” arrow to appear 
in the camera frame from the bottom of the line to the top of the line. 
Although the vector will jump around a little bit, you’ll need to make 
adjustments to minimize the jumpiness of the vector. To do this, make 
the following changes:

• White line – Make sure this box is unchecked. You would check this 
box only if you were to have a white line with a black background.

• Camera brightness – The camera brightness needs to be such that 
there is a good contrast between the whiteness of the paper and 
the blackness of the marker line. Move the slider for the camera 
brightness to a middle value of about 128. 

• Minimum line width – This parameter sets the minimum width of a 
detectable line in pixels. The thinner your line, the lower this value 
needs to be. Use the slider to change the minimum line width to 
about 2 pixels. This value should work unless you used a very thin 
marker; in which case, go ahead and set the value to 0.

• Maximum line width – This parameter sets the maximum width of a 
detectable line in pixels. The wider your line is, the higher this value 
should be. Start with the slider at 0 and drag it to the right until you 
see the red arrow labeled “Vector” appear in the PixyMon camera 
frame. Continue dragging the maximum line width to the right until 
the Vector arrow in the camera frame reaches from the bottom of 
the line to the top of the line and is stable (meaning it doesn’t jump 
around a lot.)

• Edge threshold – This parameter determines how sensitive Pixy2’s 
line detection algorithm is. A lower number means more lines will 
be detected, whereas a higher number means fewer lines will be 
detected. Start with this parameter at about 30. 

Experiment by making slight changes to the parameters on the Tuning tab until 
the Vector arrow in the camera fame is as stable as possible and reaches from the 
bottom of the line to the top of the line in the camera frame.

9. When you’re finished making changes to the Tuning parameters, click 
OK to close the Configure window.

Lesson Guide

18

TETRIX MAX Pixy2 Camera Extension Activity

https://docs.pixycam.com/wiki/doku.php?id=wiki:v2:line_tracking
https://docs.pixycam.com/wiki/doku.php?id=wiki:v2:line_tracking


Opening the Sketch
Launch the Arduino Software (IDE). Open the PixyCam_Line_Following sketch by 
selecting File > Examples > TETRIX_Pixy2_Camera > PixyCam_Line_Following. 
The sketch will open in a new sketch window.

Executing the Code
Connect the PRIZM controller on the TaskBot to the computer using the standard 
TETRIX USB cable. With the PRIZM on, make sure to select the correct port in the 
Tools menu of the Arduino IDE. Upload the example sketch to the PRIZM. When 
the code is uploaded, the green LED will light up, indicating the code is ready to 
execute. 

Use a book, a couple of short TETRIX channels, or other object to prop up the drive 
wheels of the TaskBot. Make sure that the drive wheels are off the tabletop. This will 
let you test the robot without it moving.

From the Tools menu, launch the serial monitor. This will let you observe the 
TaskBot’s behavior. It might help to arrange the windows on your computer screen 
so that you can see both the PixyMon software and the serial monitor at the same 
time. When you’re ready, press the green Start button on the PRIZM controller to 
run the line tracking program.

Place your paper with the line drawn down the center on the table under the 
Pixy2 camera. Rotate the paper back and forth. Observe the TaskBot’s behavior as 
its motors stop and start and watch the serial monitor to see how these behaviors 
cause the TaskBot to move.

Note: In the bottom-right corner 
of the serial monitor, make sure the 
first drop-down menu is set to No 
line ending. The baud rate drop-
down menu should be set to 9,600.
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Create a route for the TaskBot to follow by taping several pieces of paper together 
on the ground. With the black marker, draw a line on the paper for the TaskBot to 
follow. Include some curves, straightaways, and s-turns when creating your route. 
Unplug the TETRIX USB cable from PRIZM and place the TaskBot at the beginning of 
the line. Press PRIZM’s green Start button to run the line tracking program. Does the 
robot track and follow the line to the end? 

If time permits, experiment with Pixy2’s line tracking algorithm. Here are a few 
things to investigate:

• How sharp of a turn can the TaskBot make and still follow the line?

• How thin of line can the Pixy2 camera track and follow?

• What happens if two lines intersect? Which line will the TaskBot follow?

Lesson Guide
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Moving Forward
This sketch starts similar to the video mode example sketch. The first four lines of code 
include the libraries that are needed and instantiate the PRIZM and Pixy2 objects.

The next two lines of code are constant declarations. The first defines the way Pixy2 
communicates with PRIZM – through the I2C port. The second creates a constant 
named xCenter that is equal to Pixy2’s frame width divided by two. In line tracking 
mode, Pixy2 has a total frame width of 79 pixels (0 to 78), so half of this frame width 
is 39.5 or, rounding up, 40 pixels. Therefore, the xCenter constant is equal to 40.

The first four lines in the void setup() function are familiar. These commands are to 
start PRIZM when the green Start button is pressed, invert Motor 1, start the serial 
monitor, and print the word “Starting…” to indicate the Pixy2 camera is running.

The next three lines of the void setup() function are three commands for the Pixy2 
camera. 

• The first command initializes the Pixy2 camera to send data back to PRIZM. 

• The pixy.setLamp(upper, lower) command turns on Pixy2’s LEDs. This 
command has two parameters. The upper parameter controls the two white 
LEDs at the top corners of the camera. The lower parameter controls the LED 
at the bottom middle of the camera. A value of 1 will turn the upper and 
lower LEDs on while a value of 0 will turn them off.

• The pixy.changeProg(“line”) command changes the Pixy2 camera to line 
tracking mode. Recall that in this mode, Pixy2 will create a vector in the 
PixyMon software indicating the detected line to follow.
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The void loop() function of the code starts by declaring an 8-bit integer variable 
named lines. This variable will take on the form of “00000000” where each digit can 
be either a 1 or 0. In this format, each digit can represent different true (1) or false 
(0) values.

When the Pixy2 library is included at the top of the sketch, it automatically declares 
a set of global variables. One of these global variables is named vectors. When the 
command pixy.line.getMainFeatures() is called, all the information about the line 
vector that Pixy2 detects is stored in the vectors variable. Not only that, but by 
setting the variable lines equal to pixy.line.getMainFeatures(), all the features that 
Pixy2 detects are represented as a series of true (1) or false (0) values.

The void loop() function concludes with an if-else if-else conditional structure that 
tests for four different possibilities. Let’s look at each condition. The first condition 
tests to see if the lines variable is equal to or less than zero. This condition will be 
true only if:

• No lines were detected by the Pixy2 camera, in which case the lines variable 
will equal 0.

• There was an error when the pixy.line.getMainFeatures() command was 
called. In this case, the lines variable will be less than 0.

In either of these cases, the TaskBot should not move. Inside the brackets for this 
condition, the prizm.setMotorPowers(125, 125) command causes a hard stop of 
the motors and then the behavior of the TaskBot is output to the serial monitor.

Note: How the information from 
Pixy2 is stored and used can be 
quite complicated. Don’t worry if 
you don’t understand all the aspects 
of this code. You can always learn 
more by exploring the Pixy2 support 
documentation and the Arduino 
Reference site.

Pixy2 Camera Documentation: 

https://docs.pixycam.com/wiki/doku.
php?id=wiki:v2:start

Arduino Reference Site:

https://www.arduino.cc/reference/en/

Note: The pixy.line.
getMainFeatures() command 
also gets information about any 
intersections and bar codes that the 
Pixy2 detects. You can learn more 
about getting the intersection and 
bar code data from the Pixy2 support 
documentation at this link:

 https://docs.pixycam.com/wiki/doku.
php?id=wiki:v2:line_tracking
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Reference Description Values

m_x0 The x-position of the tail of the 
vector. The tail is the opposite 
end of the arrow point.

Any integer between 0 and the 
maximum frame width of 78.

m_y0 The y-position of the tail of the 
vector. The tail is the opposite 
end of the arrow point.

Any integer between 0 and the 
maximum frame height of 51.

m_x1 The x-position of the head of the 
vector. The head is the tip of the 
arrow point.

Any integer between 0 and the 
maximum frame width of 78.

m_y1 The y-position of the head of the 
vector. The head is the tip of the 
arrow point.

Any integer between 0 and the 
maximum frame height of 51.

m_index A tracking number assigned to 
the vector or detected line. Each 
new line that Pixy2 detects will 
get a new tracking number. That 
number stays with each line until 
the line leaves Pixy2’s field of 
view or the line can no longer 
be detected due to other factors 
such as low light.

Any integer from 0 to 255, 
depending on the number of 
lines detected by Pixy2.

The first else if condition checks to see if the tip of the vector detected by Pixy2 is to 
the left of the camera frame. Recall that the command pixy.line.getMainFeatures() 
stores all the main features of the vector into a variable named vectors. This 
variable holds several pieces of data. The table here shows some of the data stored 
in the vectors variable and how it is referenced.
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The code pixy.line.vectors->m_x1 reads from the vectors variable and returns the 
x-position of the head of the vector. This value is compared to the xCenter variable, 
which is the center of the frame. So, if the vector head is to the right of (greater 
than) the center of the frame, then the TaskBot needs to turn right. Inside the braces 
for this condition, the prizm.setMotorPowers(30, 125) command causes the 
TaskBot to turn right. Then, the TaskBot’s behavior is output to the serial monitor.

The second else if condition is similar to the first, only this time the code is looking 
to see if the head of the vector is to the left (less than xCenter variable). If this 
condition is true, the prizm.setMotorPowers(125, 30) command causes the 
TaskBot to turn left, and then its behavior is output to the serial monitor.

If none of the above conditions are true, then the else part of the if-else if-else 
conditional structure is executed. For the else part to execute, a vector must be 
detected that isn’t pointed right and isn’t pointed left. The only other place the 
vector could be pointed is straight up at the center of the frame (xCenter variable). 
When this is the case, the TaskBot just needs to drive straight forward. The prizm.
setMotorPowers (30, 30) command causes the TaskBot to move forward at 30% 
power, and then its behavior is output to the serial monitor.

Real-World Connection
Line-tracking robots are commonly used in industry and logistics to move items 
around warehouses. Many modern vehicles use line-detecting cameras to alert 
drivers when they cross the center or edge lines on the road. But one place you 
might not think of line detecting being useful is in athletics. Line-tracking robots 
are now used to pace track and field athletes by following the lines on the track 
at a certain speed. Runners input the time they want to run, press go, and follow 
the robot around the track. In football practices, padded robots are being used as 
simulated players to reduce injuries. Using the lines on the football field to help 
them navigate, these robots can block, run routes, and even play defense. When 
tackled, they pop right back up and are ready to go again.

From here, the void loop() function continuously repeats. 
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Step 1 Parts Needed

Building Interlude: Rotating the Pixy2 Camera

Step 1.0
Loosen the button head cap screws and kep nuts that connect the angle corner bracket to the L bracket. This should allow 
the Pixy2 camera to rotate. Don’t remove the screws from the nuts completely.

Building Interlude

Assembled TaskBot
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Step 1.1
Rotate the camera arm so that the Pixy2 camera is pointed out at a 90-degree angle to the ground.

Step 1.2
Tighten the screws in the angle corner bracket to hold the camera in position.

Building Interlude
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Object Recognition with Color Connected Components Mode
Not only can the Pixy2 camera be used to detect color and follow lines, it can also 
detect and track objects. This makes Pixy2 a very powerful sensor and useful for 
all kinds of applications. In this activity, you’ll train Pixy2 to recognize two different 
traffic signs. The TaskBot will either drive forward or stop, depending on which sign 
the camera sees.

Building the Knowledge Base
In order to detect a certain object, Pixy2 must be trained to recognize that object. 
The camera uses a color-filtering process to detect objects. It then outputs all kinds 
of information about the objects it sees, such as width, height, x- and y-position 
in the frame, at what angle the object is to the camera, and how long the object 
has been in the frame. The Pixy2 camera can be trained to see seven different 
color signatures as well as multiple color code combinations for even more object 
recognition capabilities.

Before you can program the TaskBot to react to objects that Pixy2 sees, you first 
need to train Pixy2 to recognize certain objects. Follow these steps to get started:

1. Leave the Pixy2 camera attached to the TaskBot. Connect the Pixy2 
camera to the computer using the micro USB cable. You should see the 
LED on the Pixy2 light up for a short time. Make sure the LED turns off 
before proceeding.

2. Launch the PixyMon software. The software should display the video 
feed from the camera.

3. From the Program menu in the PixyMon software, choose color_
connected_components.

4. In case your Pixy2 camera has already been trained to recognize objects, 
let’s reset the camera. From the Action menu in the PixyMon software, 
choose Clear all signatures. This will erase the color signatures stored in 
the camera for recognizing objects. 

5. Locate the stop and go signs in the Appendix of this guide. These are 
the two objects that you’ll train Pixy2 to see. Print out this page from the 
Appendix. Then, cut out each sign with scissors.

Note: Pixy2’s LED must be off before 
it can be trained to recognize an 
object.
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6. Press and hold the button on top of the Pixy2 camera. After one second, 
the LED on the camera will turn white and then cycle through different 
colors – red, orange, yellow, green, light blue, dark blue, and purple. Each 
of these LED colors represent one of seven different color signatures. 

Each signature can represent a different object. Release the button when 
the LED turns red (Signature 1).

7. When the button on Pixy2 is released, it goes into “light pipe” mode. In 
this mode, Pixy2’s LED will change to the color of the object in the center 
of its frame. Hold the red stop sign in front of Pixy2 about 10 to 15 inches 
away from the camera. Make sure the stop sign is in the center of the 
frame. Pixy2 will try to lock onto the stop sign. 

Look at the object in the PixyMon software. The software will place a grid 
over the stop sign. Try to get the grid to cover as much of the stop sign 
as possible by moving the sign around a bit. The more the grid covers 
the sign, the better the Pixy2 will be able to lock onto the stop sign.

Note: The LED color that represents 
a signature does not have to match 
to the color of the object you want 
Pixy2 to detect. In other words, you 
could use the dark blue signature 
(Signature 6) to represent an object 
that is yellow. But for simplicity, we’ll 
use red (Signature 1) to teach Pixy2 
the stop sign and green (Signature 
4) to teach Pixy2 the go sign.

Note: You can also use the LED on 
the Pixy2 camera to determine how 
well the Pixy2 has locked onto the 
stop sign. The LED will change color 
to match whatever color the object 
is in the center of the frame (in this 
case, red). The brighter the LED is, 
the better the lock on the object.

Note: It can be easy to teach 
Pixy2 an object using the wrong 
signature. For example, you might 
have released the button when 
the LED was orange (Signature 2) 
instead of red (Signature 1). When 
this happens, simply press and hold 
down Pixy2’s button until the LED 
turns off, canceling light pipe mode. 
Then, start the process over again.

Signature LED Color

None White

1 Red

2 Orange

3 Yellow

4 Green

5 Light blue

6 Dark blue

7 Purple

8. When you have a good lock on the stop sign, press and release the 
button on top of the Pixy2 camera one more time to exit “light pipe” 
mode. Pixy2 has now learned the stop sign.

9. Repeat Steps 6-8 to teach Pixy2 to recognize the go sign. This time, 
instead of releasing the button on Pixy2 when the LED is red, wait until it 
turns green. You’ll use the green color signature (Signature 4) for the go 
sign.
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10. Click the Settings gear in the PixyMon software. Make sure you’re on 
the Pixy Parameters (saved on Pixy) tab. Then, go to the Signature 
Labels tab. In the Signature label 1 text box, type “Stop Sign.” In the 
Signature label 4 text box, type “Go Sign.” If there are signature labels 
for Signatures 2, 3, 5, 6, or 7, then delete the text from the label text box. 
Click OK to close the Configure window.

11. Hold the stop sign and go sign up in front of the Pixy2 camera. In the 
PixyMon software, you should see that Pixy2 recognizes both objects by 
putting boxes around both objects. You should also see the signature 
labels in the center of the boxes. Move the objects around and notice 
how Pixy2 tracks the objects.

You’ve now trained Pixy2 to recognize both objects.

Note:  If you don’t see the signature 
labels appearing, then you’ll likely 
see other text indicating the 
signature number that the sign is 
associated with (for example, s=3 
indicates Signature 3). If this is the 
case, then go back to the Signature 
Labels tab from the Settings gear. 
Move the text for your signature 
label to match whichever signature 
the sign is associated with.
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Opening the Sketch
Launch the Arduino Software (IDE). Open the PixyCam_Object_Detection sketch 
by selecting File > Examples > TETRIX_Pixy2_Camera > PixyCam_Object_
Detection. The sketch will open in a new sketch window.

Executing the Code
Connect the PRIZM controller on the TaskBot to the computer using the standard 
TETRIX USB cable. With the PRIZM on, make sure to select the correct port in the 
Tools menu of the Arduino IDE. Upload the example sketch to the PRIZM. When 
the code is uploaded, the green LED will light up indicating the code is ready to 
execute. 

Use a book, a couple of short TETRIX channels, or other object to prop up the drive 
wheels of the TaskBot. Make sure that the drive wheels are off the tabletop. This will 
let you test the robot without it moving.

From the Tools menu, launch the serial monitor. This will let you observe the 
TaskBot’s behavior. It might help to arrange the windows on your computer screen 
so that you can see both the PixyMon software and the serial monitor at the 
same time. Press the green Start button on the PRIZM controller to run the object 
recognition program.

Place the green go sign in front of the TaskBot. You should see the wheels start to 
move. Place the red stop sign in front of the TaskBot. You should see the wheels 
stop. Notice the output being sent to the serial monitor. What happens if you put 
both the stop sign and the go sign in front of the TaskBot?

Press PRIZM’s red stop button to stop the program from running. Unplug both USB 
cables from the PRIZM and Pixy2 camera. Place the TaskBot on the floor in an area 
with lots of room. Press the green Start button on the PRIZM controller to run the 
program again. Test the TaskBot’s response by placing the go sign and stop sign in 
front of the camera. Try to mimic the behavior of an actual traffic signal. Does your 
robot obey the traffic signals?

Note:  You might see varied 
results of success and failure due 
to the lighting conditions in the 
area you are testing your robot. 
Pixy2 has several settings you 
can adjust to tune the camera’s 
ability to detect objects in different 
light levels. To learn more about 
tuning the camera, visit the Pixy2 
documentation at this link:

docs.pixycam.com/wiki/doku.
php?id=wiki:v2:some_tips_on_
generating_color_signatures_2

To tune the Pixy2 camera, you’ll 
need to plug the micro USB cable 
into the camera so you can see what 
Pixy2 sees through the PixyMon 
software.
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Moving Forward
Let’s dive into the sketch to see how the program for object detection works. At 
the beginning are the commands for including the libraries, defining how Pixy2 
communicates with PRIZM, and instantiating the Pixy2 and PRIZM objects.

Next, there are three variable declarations. One to count the number of stop signs 
the Pixy2 camera sees, one to count the number of go signs the camera sees, and 
one to store the motor power. These variables will be used later in the sketch.

Most of the commands in the void setup() function should be familiar from 
other sketches in this guide. The only new command is pixy.changeProg(“color_
connected_components”), which sets the mode of the Pixy2 camera so it can 
recognize objects based on color.

The void loop() function starts with the pixy.ccc.getBlocks() command. This 
command gets the information for each block that is detected by Pixy2 and stores 
it in a variable. A block is simply an object that Pixy2 has been trained to see and 
shows up in the PixyMon software. This command must be run first in order to use 
the data from the Pixy2 camera.

When the pixy.ccc.getBlocks() command is executed, the number of blocks that 
Pixy2 sees is stored in a variable called pixy.ccc.numBlocks. The next section of the 
sketch is an if statement that uses the pixy.ccc.numBlocks variable to see if Pixy2 
sees any blocks. If pixy.ccc.numBlocks is greater than zero, then the Serial.print() 
commands inside the braces are executed. These commands print the number of 
detected blocks (which are stop and go signs in this case) to the serial monitor.

Also inside the if statement is a for loop. The for loop will run pixy.ccc.numBlocks 
times. In other words, the loop will run one time for each block that Pixy2 sees. This 
way, the sketch can check the signature of each block, one at a time, to see how 
many stop and go signs the Pixy2 sees.

The first command inside the for loop prints all the data collected for a particular 
block. This data includes the signature (1-7) of the detected block, the x- and 
y-position of the center of the block, the width and height of the block, the block’s 
index (a different ID number assigned to each block), and the age of the block by 
camera frames.
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Next is an if-else if conditional structure. In the first condition, pixy.ccc.blocks[i].m_
signature is the signature of the current block that is being checked. Recall that 
when you trained the Pixy2 camera to recognize the stop and go signs, the stop 
sign was set as Signature 1 and the go sign was Signature 4. So in this condition, 
if the signature of the block is equal to 1, then the sketch knows that Pixy2 sees a 
stop sign. Therefore, in the next line, the counter variable that is counting stop signs 
is increased by 1.

The else if part of the conditional is similar to the if part. But this time, the sketch is 
checking to see if the Pixy2 sees a go sign (Signature 4). If it does, then the variable 
counting go signs is increased by 1.

If neither of these conditions is true, then the block must be some other signature 
and can be ignored. The for loop then repeats checking the next detected block.

After the closing brace of the for loop is another if-else if conditional structure 
that compares the number of stop and go signs that the Pixy2 sees. In the first 
condition, if there are one or more stop signs, then the mPower variable that tracks 
the motor power is set to 125. Remember that a motor power of 125 is a hard 
stop. This condition will be true even if the Pixy2 sees a go sign. That means that if 
Pixy2 sees both a stop and a go sign, it will stop. The else if part of the structure is 
checked only if the first condition was false (in other words, if no stop signs are seen 
by Pixy2). So, if no stop signs are seen, and if at least one go sign is detected, the 
mPower variable is set to 50 for 50% motor power. This condition also ends the if 
statement that checks to see if the number of blocks detected is greater than zero 
up near the top of the void loop() function.

The final three lines of code run no matter if Pixy2 sees blocks (the signs) or not. The 
first command sets the motor powers to the mPower variable. Recall that this value 
will either be 125 or 50 depending on which signs are seen by Pixy2. The last two 
commands reset the variables that count the number of stop and go signs detected 
by Pixy2.

From here, the void loop() function repeats.
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Real-World Connection
Object recognition has all kinds of applications. One area is in the security industry. 
You’ve probably heard of facial recognition software that will scan your face and 
grant you access to your mobile phone. This same technology is being used 
for security in the workplace and in homes as well. But object recognition goes 
beyond scanning faces. Security cameras are being developed that can tell the 
difference between an intruder at the front porch and a neighbor’s curious dog 
that is investigating the front bushes. Some cameras can even distinguish between 
a thief and a mail carrier. There’s no doubt that object-recognition technology will 
continue to expand in the years to come.

Lesson Guide

Hacking the Code Activity
Using the example sketch as a reference, try creating a new sketch to have the 
TaskBot complete a maze or obstacle course using the Pixy2 camera. Create new 
signs for left and right turns and train Pixy2 to recognize these signs. You could also 
create signs that cause the TaskBot to move at different speeds – like the yellow 
caution light on a traffic signal. When finished training the Pixy2 and programing 
the TaskBot, run the maze or obstacle course to test your sketch.
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Appendix

34

TETRIX MAX Pixy2 Camera Extension Activity


